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1. Interface 

The most evident changes of the graphical interface of ARCHLine.XP can be seen on the Toolbars. 
The followings are grouped together: 
 

� Toolbox 
� Design Center 
� The new Property manager.  

 
So those take less room from the drawing area. Clicking on the tabs on the bottom you can switch from one to another. 
 

 
 

As a new possibility, these 3 units can be represented only by their names, while their content is hidden but can have 
those shown up at any time.  
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The new Properties manager can handle the properties of elements from a single integrated interface. Each modification 
appears on the drawing immediately. With the application of multiple selections and filtering the design work can be speed 
up substantially. 
 
The graphical interface is customizable. You can assign your own keyboard shortcuts to commands, custom toolbar can 
be created with your own icons. 
 

1.1. Toolbox 
The Toolbox contains the designing tools, Modeling, Drafting, Dimension folders up to the 3D solid modeler commands. 

   
 
In the toolbox you find the icons of all element types (line, wall, slab, … ).  
When the icon bottom right corner is filled with a small rectangle, it means you can activate the related submenu. The 
icons are available by short or long mouse click. 
 

 
 

1.1.1. Short click, Long click  
The Toolbox can be managed by short and long mouse clicks: 
 

� Short Click with the mouse left button on an icon. The related command is executed. 
� Long Click with the mouse left button on an icon. The related submenu of the selected tool element appears. 
� Short Click with the mouse right button on an icon. The Properties dialog appears where you can define the initial 

properties of the selected element type. The elements that are going to be drawn later will have these properties. 
� CTRL + Click with the mouse left button on an icon. The command selects all elements on the drawing from the given 

element class. Example: The elements that are selected can be modified together with the Properties. 
 

� Click with the mouse left button on an icon in the submenu. The related command is executed. 
� Click with the mouse right button on an icon in the submenu. The Edit keyboard shortcuts and toolbars dialog appears. 

Here you can easily assign a shortcut to the command. 
 

� The Properties dialogs are available from the Properties menu as well.  
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1.1.2. Toolbox setup 
You find it on the File menu – Preferences – General command. 
 
Short way to call the toolbox setup: Click with the mouse right button on one of the Toolbox group header (e.g. Modeling). 
 

 
 

 

Long click speed 
Here you can customize the long click delay time to display the related submenu. Move the slider to define the optimal 
delay time for your working style. 

1.1.3. Toolbox working modes 
� Standard mode 
� Learning mode 

 
Choose the required working mode: Standard or Learning. 

Standard 
The Main icon is fixed. The short click on the main icon will execute the related command. The long click on the main icon 
displays the subdialog and you can choose a command firm this dialog with the next click. 
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Learning mode 
The Main icon is replaced by the submenu last selected command’s icon, so it ’learns’ the last used icon and put it in the 
Main icon position. The next short click on the main icon will execute the last selected command. 
 

  
 

� The learning mode is recommended to advanced users. 
 

1.2. Property manager 
The Property Manager is a user interface tool to visualize the properties of the selected objects and display and modify its 
values. 
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The program denotes with light red background color all the properties that cause the loosing of the assigned set name if 
you change any of those. This applies only to the elements that came from a set, of course. For example, in case of wall 
the WIDTH is such a property. 

Multiple selections 
In case of multiple selections the Property grid displays the common values of the selected objects. 
The not common property fields are filled with the VARIES indicator. 
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1.2.1. Sub-Selection with Property Manager 
The Properties Manager offers new interface for selecting objects. You can access selections or sub-selections within this 
command to limit the objects that you want to modify. When you make a selection within the properties manager and that 
selection is made up of different types of objects, the selection dropdown will indicate the word "Selected (n)". This is an 
indicator that your selected objects are not all the same type (for example: you may have a selection made up of lines, 
walls, slabs and columns). By clicking the down button at the right of the dropdown list, you can access a subset of this 
total selection. 

 
 
An example of where this can be very useful is changing the properties of an object type with a common property, e.g. 
select all the walls on a complex floor plan. Simply make a selection of the entire drawing drop down the list and choose 
Wall (n). Now you can change the properties common to all walls.  

1.2.2. Intersection of two-or more selections 
The Properties Manager enables of intersection of two or more selections. You can access common part of two selections 
with this command to limit the objects that you want to modify for example to select all walls with the same wall width. 

Example:  
Supposing that we have a floor plan that contains walls and some of them have the property of wall width with the value of 
380 mm. We want to modify the height of these walls to 3000 mm. 
 

• Zoom all objects on the screen and click on the upper left corner on an empty area and next on the bottom right corner on 
an empty area. In This way you have selected all visible objects on the floor plan.  

• Now press the INTERSECTION icon and click on QUICK SELECT icon and choose the Wall width criteria. Type a value 
as 380 mm in the current measurement unit and press Ok. Press ENTER to close the current command.  
 
The program displays the common part of the two selections.  
Now you can modify easily all the walls that have the property of the same wall width. E.g.: height = 3000 mm 
Their width can be modified at once only if none of them is derived from a set. The VARIES indicator with the red 
background reminds you to this. 
 

 

1.3. Design center 
The structure of the design center has been simplified. Its basic function is to make easy the finding of elements found in 
the libraries and then placing them quickly on the drawing by drag and drop. 
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Therefore we kept the following element types: 

 
 

1.4. Command line 
The Command line suggests the most appropriate step at all times and displays errors or other messages. In this line you 
can often see commands with capital letters as a possible next step of the current command. We call them sensitive 
keywords. To issue a command, simply click on it with the mouse. The sensitive keywords can be found in the input list as 
well or enough to type the first character sequence indicated with capital letter(s) to activate it. 
 

 
 

 

Command history 
The executed commands and prompts are saved in the command line history and listed below. 
 
 

 

Input field 
If you switch off in the File menu – Preferences – General – Shortcut icon menu setting dialog window the Enable dynamic 
input option, then you can use the Input field to take in the values. 
 
The Input field is activated automatically when an action is made on the keyboard. Simply pressing a numerical or 
alphabetical key, the Input window is activated in which you can type values, texts, expressions or commands.  
 

 
 

You can activate your input with the OK button. 
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1.5. Floor listbox  
Direct and fast new control for selecting new active floor. 
  

 
 

1.6. New general property manager 
This is the new interface of the central definition dialog of general properties. The dialog can be activated by clicking the 

  icon. 
 
The general property manager is aimed to specify the initial property values of the selected element type. Elements 
created later will take their properties from here. 
 

! Do not mix the general property manager dialog up with the property dialog aimed to modify the actual properties of an 
element! 
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2. Object Linking and Embedding - OLE  

Overview  
OLE (Object Linking and Embedding) is a Microsoft specific technology for inserting an object into a document. The object 
can be later opened and edited with its parent application, in the destination document you can only change the outfit of 
the displaying (size, position etc.). 
 
You can create compound documents in ARCHLine.XP by linking or embedding objects from other applications. For 
example, you can insert a table from a spreadsheet application, a set of notes from a word processing application, and a 
graphic image from a paint program. By inserting the desired objects into your ARCHLine.XP drawing, you create a 
compound document.  
ARCHLine.XP provides the general tools for editing an OLE object but do not affect OLE objects itself. You can select 
OLE object and erase it with the ERASE command, or can you resize or rotate it using the SCALE or ROTATION 
command. 
 
ARCHLine.XP provides several options for linking and embedding objects in drawings. 
There are two possible ways to insert an OLE object:  
 

� Embedding 
Embedding of an object means that a copy of the source document will be placed in the destination. No changes of the 
source document will be applied on the inserted object. It's very similar to 'copy and paste' the only difference is that the 
object can be edited with its creator application. 
 

� Linking 
When inserting an object by using the method 'Linking' only a reference will be placed in  the destination document. This 
means when the source document is modified, the changes appear in the destination document, too. 
 
You can use OLE with any two application, where both support it. 

2.1. Inserting an OLE Object 
To insert an OLE object into a drawing you have to do the following steps: 
 

• Select Tools menu 
• Select Insert OLE 

You will see this dialog box: 

 
 

� The listed object types can be different depending on the file types registered in your operation system. 

Creating the object newly  
This option lets you create the object 'on the fly'. It means no source document will be stored on your hard disk. Of course 
this method only supports Embedding. 
 

• Select Create new 
• Choose the desired object type and push OK 
• The associated application will start and you can create the object to be inserted.  
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• When finished select File menu in the source application and then Update.  
• Return to the window of ARCHLine.XP 
• Place the object into the drawing as explained in the chapter Placing the object 

Inserting an existing object 
You can insert an object created previously. In this case it's possible to use both methods of inserting. 

Embedding 

 
 

• Select Create from File 
• Select the file by entering its path or with the Browse button 
• Leave the checkbox Link empty 
• After pushing OK place the object as explained in the chapter Placing the object 

Linking 

 
 

• Select Create from File 
• Select the file by entering its path or with the Browse button 
• Check the checkbox Link  
• After pushing OK place the object as explained in the chapter 1.3 Placing the object 

 

� OLE objects can contain much more information than which can be displayed in a drawing. If you leave the checkbox 
Display as Icon empty a file type depending part of the document will be displayed. If you check it, only an icon will be 
placed on the drawing. 

Placing the object 
After selecting the insertion method and picking the object you have to place it on the drawing.  
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• The first way is clicking at two locations. The object will be placed in the rectangle of which opposite corners are the two 

selected points. The size of the object will be the maximum considering that the width-height rate won't be changed. The 
object won't be rotated. 

• If you want to rotate the object before placing it, you can use either the option XANGLE or GRAPHIC. These can be 
selected by clicking on them in the Command Prompt. The first is used for entering the rotation angle with a number, the 
second is used for entering it on the drawing manually. After defining the angle you have to draw the rectangle in which 
the object will placed with the same conditions as in the first case. 

2.2. Modifying the object 

 
 
Although the OLE objects can be edited with their parent application a few modifications can be applied with 
ARCHLine.XP after they are placed. These can be reached by right clicking on the object: 
The special items and their meaning are the following: 

Frame/Show 
This switch is used for changing if the object is displayed (with the restriction mentioned at the end of the chapter 1.2 
Inserting an OLE object) or only the frame of it. 

Refresh 
This menu item is used for refreshing the object. It means that it is updated with the changes made on the source 
document. 

Open 
It opens the object in its parent application for editing. 

Save Document 
This item saves the object in a file. This can be useful if you created the object with the Create New option and later you 
have to use it in another document. 
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Properties 

 
 

This can be used for modifying some appearance setting of the object. This can be done via the following dialog window: 
The meaning of the blocks are the following: 

Resizing 
You can choose the reference point of resizing when the object is opened for editing and its size is changed. This point 
keeps its location. Keep the actual frame means that the object will be resized while inserting. 

Insertion Point 
You can define the location of the left bottom corner of the frame. You can do it by entering the coordinates (leave the 
checkbox empty) or by clicking somewhere on the drawing (check the box). 

Size 
It's used for resizing the object. It can be done with the length of the sides or by clicking on the screen (use the checkbox 
Specify on-screen). The small figure shows if the scale is fixed (green) or variable (red). It can be changed by clicking on 
it. The reference point will be the left bottom corner. 

Rotation 
This is used for rotating the object. The reference point will be the left bottom corner and the opportunities are the same as 
in the previous two blocks. 

Transparency 
The default transparency of OLE objects is opaque. In this block you can change the background color (the area of the 
frame rectangle where the source document has no data) or make the object transparent by emptying the checkbox 
Background is filled. 
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3. File management 

3.1. New general import dialog  
New general import dialog for 3DS, SKP, OBJ, formats.  
 

 
 

3.2. File compatibility : SketchUp files 
Importing SketchUp Files 

ARCHLine.XP  can open and import SketchUp file directly.  
ARCHLine.XP comes with the reader for SketchUp (.skp) file format.  
You will find it in the FILE, Import…, SketchUp menu point. 
By default, SketchUp models are imported as polyfaces.  
You can change the size of the SketchUp files are imported by using the New general import dialog Scale option before 
you place the SketchUp object into the 3D window. See 1.2. 

Export to ArtLantis (.atl)  
ARCHLine.XP model can be exported to the ArtLantis (.atl).  

3.3. Import 2D DWG -> 3D  
It is possible to place an imported 2D drawing (DWG, DXF or ASC) onto a selected plane in a 3D window. 
In the 3D drawing window, based on this drawing, the model can be created by the recognized special points. 
 

• Activate the 3D drawing window where a solid, for example a slab, exists already. 
• Use the File menu – Import – Import command. 
• Select the desired 2D drawing. 
• Select the Place in 3D plane option. 
• Select the plane where you want to place the drawing. 
• Enter  Accepts the selected plane. 
• Place the drawing onto the plane. 

 
Using the special points of the drawing, from the architectural elements you can create the model in 3D. That time the 
floor-plan will be created as well, of course. 
Switching the 3D drawing window into 3D image window, the model can be easily rotated. 
 

! The 2D drawing remains on the 3D plane until the regeneration of the solid where the drawing is placed. With the 
reopening of the project you will also lose the drawing. 
The 3D image window can be used only for representation in that case, the special points of the imported 2D drawing 
cannot be used here. 
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4. Section  

Overview - Dynamic sectional drawing 
Section view is one of the most important features of computer aided architectural designing. 
The section view is derived from the model of the building and appears as a new drawing in accordance with the model. 
The program generates the section view in a new 3D window, perpendicular to the cutting plane. 
You can create as many section views of a building as you like. The section view dynamically follows the changes made in 
the model. 
 
In the section view you can select each element and you have access to the architectural objects. You can change objects 
in the section view as well as on the floor plan. 
Section view can be combined with vectorial shadowing and with vectorial hatching but it requires longer generation time. 
Vectorial shadows can be calculated from the sun or from an arbitrary angle. 
 
The representation of the section line is defined by a standard that is acknowledged in the field of technical drawing. The 
section line is a dotted-dashed line with letters (the section’s letter symbol) and with arrows at the ends, which show the 
direction of the section view.  
 
Moving, rotating or mirroring of the section line with the use of section line markers on the floor plan refreshes 
the section view automatically. 
The section line is visible on the view where it was created. 
There section view enables the visualization of objects crossing the section plane with or without material hatches and 
with thin or thick contour lines. 
 
In the ARCHLine.XP out of the dynamic sectional drawings the following opportunities are available to create different 
kind of sections: 

Static section 
If you did not work out the model in detail, the section provides a good basis for further editing. 
With the help of the program’s clipboard, you can copy any 3D views or sectional views to the floor plan window. The 
copied drawing loses its connection with the 3D model, therefore it can be freely edited, the view or section can be 
”dressed up”. For instance, you can specify the order of layers, which you have to indicate on the plan, but it was not 
represented on the model. With this option the program provides considerable freedom to the designer. 

Stepped section in a 3D section window 
Section line can be created in a 3D façade view (vectorial drawing) window, too, even in a stepped form. In that case the 
newly created section window will include a stepped section. 

Cutting a 3D model 
You have the possibility to cut a model with a stepped section line and display the result on a rendered image. This 
command really cut the 3D model. 

Dynamic cutting plane 
Applying the dynamic cutting plane in an OpenGL image window, you can represent the dynamic section in real time. This 
representation is very useful, not just for aiding the architectural design work, but for a spectacular representation of the 
building to the customers, too. 
 

4.1. Dynamic section 
You can generate the section of the model with the commands in the View menu – Section submenu.  
 

 
 
Follow the steps below to create a dynamic section: 
 

• First you have to set the properties of the section line, including the lower and upper height limits of the section.  
• Then you have to define the path of the section line and set the view direction.  
• The program then generates the sectional view of the model in accordance with the section line in a new section window. 
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In the section window the program refreshes the sectional view when changes are made to the model. This can be 
automatic or optional.  
Any changes made to the model in the section window, e.g. deletion of a wall, will appear on the floor plan. 
The section window follows the section line: Moving, rotating or mirroring the section line on the plan view by any markers, 
the section view will be updated immediately 
The quality of the sectional view depends on how detailed the model is, i.e. if there are multi-layered walls, slabs, whether 
you specified how layers are joined. 
 
The following rules are applied when you create a section: 
 

� When creating a 3D sectional view, the name of the window will be generated automatically (Section1, Section 2 etc.). In 
the File menu – Project properties dialog you can rename the name of the section window (the original name of the file 
that represents the section window will not change). 

� One 3D section window belongs to each section line. This way the connection of one section line to more 3D section 
window, which makes the section unidentifiable after some time, can be avoided. 

� If a 3D section window that belongs to a section line is in invisible state (you can check it in the File menu – Project 
properties dialog) then the create section command will pop up a warning message and no new 3D section window will be 
created. 

� If a visible 3D section window belongs to an existing section line then the section window will be refreshed by the Create 
command. 

� The identification of sections that have been already created in older projects (created by versions prior to ARCHLine.XP® 
2007 Release2) is not working. 

 

4.1.1. Defining a section 
Activate the floor plan. To create a section, follow the steps below: 
 

• Click View menu – Section – Define or Edit toolbar -  Define section icon. 
• The Section properties dialog appears. Specify the properties of the section. 
• Give the start end the end point of the section line on the floor plan. 
• Click on the side of section line where the sectional model is viewed from. The program places the arrows on that side of 

the section line. 
• In the appearing message window confirm the creation of the section view. 

 
A dynamic section view is created then in a new section window. 

	 See chapter 4.1.2. Section properties settings, 4.1.3. Defining the section line, 4.1.4. Creating sections for the details. 

 
 

� Besides the appropriate setting of view properties in the 3D window (right view, front view etc.), the section view is also 
capable of creating façade view. In that case place the section line outside of the building and set the proper view 
direction. 
 

4.1.2. Section properties settings 
The indication of the section line is defined by a standard that is acknowledged in the field of technical drawing. The 
section line is a dotted-dashed line, with letters (the section’s letter symbol), and with arrows at the ends, which show the 
direction of the sectional view. 
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You can define the section properties in the dialog: 
 

 
 

Line properties 
Set line properties: 
 

� the section’s letter symbol:   

� position of letter symbol:    

� visibility of letter symbol:  
� the lower/upper limit of section: you can disable this option, or you can set a value 
� color of section line 
� type of section line 
� width of section line 

� width of marker line:   

Marker properties 
Set marker properties: 

 
� color  
� line width 
� length of marker line 
� size of marker 
� type of marker 
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Hatching section plane 
When you generate a sectional view, the program does not apply hatch automatically to the cutting planes, because in the 
case of big models it would take too long. If you want to apply hatching to the cross-sectional cutting plane, activate Hatch 
section plane option.  
You can also set the line width of the contour line applied to cross-sectional cutting planes. 

 

� The Hatch section plane option and the hatch line thickness can be reached in the File – Preferences – General – 3D 
preferences dialog box. 

 

Section symbols 
On the ends of section line you can apply different symbols instead of arrows. 
 

• In the Section properties dialog select the Symbol on the ends of section line option. 
• Click the belonging button and select the appropriate symbol from the Section endings library. 
• Enter the value of the variables. For example A 1  
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OK Close the dialog box. 

4.1.3. Defining the section line 
After closing the Section properties dialog: 
The path of the section line which will be used for creating the section of the model can be defined as line or chain of lines 
and arcs. 

Line 
• Specify the two end points of the section line. 

Chain of line and arcs 
• Choose the PLINE keyword in the prompt line. 
• Define sectioning line with a chain of lines and arcs. You can break the sectioning line. 
• Enter  close the section line. 

 
• To define the direction of the sectional view, click on the side of the sectioning line from which you observe the model. The 

program places the markers on this side of the sectioning line. 
 
The program places the marker at the selected place. 
 
After the definition of the section line, the program offers the creation of it. See 4.1.4.chapter Creating sections. 

4.1.4. Creating sections 
After the definition of the section line, the program offers the creation of it. 
 

 
 

� Clicking on Yes will create the section.  
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� Clicking on No will leave the possibility to create the section later by the View menu – Section – Create command. 
The program creates the sectional view of the model according to the selected section line  
 
The section appears in a new window (section window), which you can save as part of the project. The program rotates 
the model according to the direction of the sectioning view. 
 

 

 

� The program applies hatch to the cross-sectional cutting planes depending on the status of the Hatch section plane 
option in the Section properties dialog box. 

You can also activate the Creating sections command with the Edit toolbar −  Create section icon, or the Section 
shortcut menu − Create command. 

 

4.1.5. Refreshing the section view 

Refresh 3D 
This command is a switch to turn on/off the refreshing of the section. 
If you disable the refreshing of section in 3D, it becomes faster to display the 3D model. This is the default setting. To 

apply this setting, you can use View toolbar −  Hidden lines or the Section − Create command to update the model. 
 
If you add new elements to the plan, and the View menu - Refresh 3D option and the Section − Refresh 3D option are 
enabled, the program automatically creates a sectional view of these objects, too. When the Refresh 3D option is switched 
off, the newly generated element will appear without hatch. 
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� If a 3D section view window belongs to a section line already, the Section – Create command will refresh that section 
view. 

4.1.6. Modifying section line 
Existing section line properties can be modified. 
 

Modify properties 
 

• Double-click on the section line. 
The Section properties dialog appears. 

• Make the desired modifications. 
• Refresh the section view. 

Changing the position 
The section window follows the section line: Moving, rotating or mirroring the section line on the plan view by any markers, 
the section view will be updated immediately 
 

• Click the section line on the floor plan: 
 
Grips appear on the section line. With the help of these grips the section line can be moved, rotated or mirrored.  
Mirroring means the changing of the viewing direction. 

 

4.1.7. Fixed view of a section window 
The view in a 3D section window can be fixed, so you can avoid the rotation of the sectional view. 
 

• Activate the 3D section window. 
• Click the Active window button in the File menu – Preferences – General – 3D Preferences dialog. 
• Switch on the Fixed view (Can not rotate) option. 
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4.1.8. Show definition of section 
For the 3D section window you can search back the belonging section line on the floor-plan. 
 

• Click with your mouse right button on the header of the 3D section window. 
• Select the Show definition of section command. 

 

 
 

4.2. Static section- Copy section view content into a 2D window 
During the design work the 3D model, the 3D dynamic section and different views are generated. Even if the model is 
prepared in details, the 3D sections and views are not capable of using them as approval drawings (because of missing 
texts, dimensioning etc.).  
 
For this reason there is an opportunity to "unlink" the section view from the 3D model and finishing the section drawing on 
approval drawing level. 
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We recommend the followings: 
 
As soon as you finished your work with the model, copy each section views into separate 2D floor plan window (for 
example 2D Sections) on different floors. For example Section A-A floor, Section B-B floor etc. You can easily activate the 
requested section view by switching between floors.   
 

� It is not recommended to create as many 2D floor plan windows as the number of section views! 
 
We recommend you to work out (”dress up”) the section views in these 2D windows.  

Copying the content of section view into a 2D window 
• Create a new window with the Window menu – New window 2D command: for example 2D Sections. 
• Make the appropriate 3D section view active. 
• Use the Edit menu – Copy to clipboard (Ctrl+C) command. 
• Select all elements in the window. Enter – close the selection. 
• Specify a reference point on the drawing. 
• Make the newly created floor plan window (2D Sections) active. 
• Use the Edit menu – Paste from clipboard (Ctrl+V) command. 
• Place the drawing in the window. Enter. 
• In the Edit floor levels dialog rename floor 0 to Section A-A, for example. Add new floors and then rename those 

accordingly. 
• Repeat the previous steps and copy each section view on the appropriate floor. 

 
• After this, work out (”dress up”) the sections. You can add text and dimensions and additional lines, groups or hatches to 

finish up your drawing. 
 
There are major differences between 2D section 3D section view windows: 
 

� The 3D section window follows the changes in the model automatically; it is connected to the floor plan. 
� The connection between the 2D section window and the 3D model is lost; changes on the floor plan are not followed. It 

includes only 2D drawing elements (line, arch, hatch…); therefore you can edit it freely. 
 

� The same method is recommended when you work on facades.  Pay attention to the setting of the correct view in the 3D 
(drawing) window, and then start the copying to the 2D floor plan window. 

Recommendation: 
The number of 2D floor plan windows is not limited but it is recommended to work with a maximum of 3 or 4 2D floor plan 
windows, ensuring a clear structure of your project. 
 

� 1 floor plan window for the real floor plan; there are floor plans on different floors 
� 1 floor plan window for the 2D sections; there are different sections on different floors 
� 1 floor plan window for the 2D facades; there are different facades on different floors 
� 1 floor plan window for the site plan; floors are not used in that case. 

4.3. Stepped section in a 3D section window 
With the Section − Create command you can create not only floor plan sections, but also you can generate a stepped 
sectional view of a 3D model. You can do it as follows: 
 

• Create a section view of the model, e.g. front view in a 3D view (drawing) window. 
• Click  Define section. 
• Draw a section line in the 3D view window and define the direction of the sectional view. 
• Allow the program to create the section or create it later by selecting the section line. 

 
Then a new section window is generated similarly to the sections defined on the floor plan. Create the stepped section by 

rotating the model properly, then refresh the window by clicking View toolbar −  Hidden lines icon.  
The section view is created in a new window then, but the model is not cut. OpenGL view and rendering displays the 
whole model. 
 

! When defining the section line, do not forget to use the Pline keyword in the prompt line! This is the way of defining 
stepped section line. 
 
Advantage:  
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The program also preserves the stepped section of 3D model in the section window after you generate the model again. 
 

   
 

    
 

4.4. Cutting a 3D model 
You also have the possibility to cut the model in the 3D view window with a stepped section line, and then you can show 
the result in a 3D OpenGL (image) window on a rendered image. 
 
For this you have to use the following commands: 
 

• Create a 3D view of the model in a 3D view (Image) window, for example. 
• Select View menu – Section - 3D model section command. 
• Select the  POLYGON and POPMENU keyword from the prompt line.  
• Choose an option from the appearing menus; the Polygon command is recommended. 
• Draw the stepped section line with the polygon. Close the profile. 
• Click on the part of the solid, which you will keep after cutting. 
• Rotating the model in the window, the stepped section will appear. 

 
The program cuts the model in the 3D view window. OpenGL and rendering displays only this part of the model. The cut 
model remains in the 3D window until you give instructions for generating the whole 3D view of the model. 
 
Advantage: 
As you cut the real 3Dmodel, you can also create photorealistic picture from the stepped 3D section of the model. 
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4.5. Dynamic section plan  
This function combines the definition and creation method of dynamic sections. For this you have to work in an OpenGL 
3D window (image). You can use this function both in axonometric and perspective views.  
 
The advantage of this function is that you can create a dynamic section defined by a section plane in real time. Therefore 
it is not just a working tool for the architects but a spectacular representation of the building. 
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Defining a section 
Create your 3D model in an OpenGL 3D window and give focus to this window. Click  Define section on the Edit 
toolbar.  
 
You will get a section like it is shown on the pictures above.  
 
Different markers appear on the edges and in the corners of the dynamic section plane. Using these markers you can do 
the followings: 
 
 Align view: This marker is found in the top-left corner of the section plane. With this marker you can create a new view 
where the section plane is parallel to the view plane.  

 
 Rotation: Rotation markers are found in the middle of the top and side edges of the section plane. With these markers 
the section plane can be rotated around horizontal and vertical axes. 

 
Resize: This marker is found in the top-right corner of the section plane. With this marker you can resize the section plane. 

 
 Shift: This marker is found in the bottom-left corner of the section plane. With this marker you can shift the section plane 
to a direction defined by a normal vector perpendicular to the section plane. 

 
 Restore default position: This marker is found in the middle of the bottom edge of the section plane. With this marker 
you can restore the default position of the section plane. By default the section plane will be resized according to the size 
of your 3D model.  

 
  Create section: This marker is found in the bottom-left corner of the section plane. With the help of this marker you 
create a dynamic architectural section.  

Rules 
Be aware of the following rules when you work with dynamic 3D section: 
 

� Size of the generated section: the size of the generated section is independent from the section plane you work with. You 
will see the whole section in every case. 

� The angle of section: in every case a vertical architectural section will be created, independently from the tilt angle of the 
section plane. 

� Section line created on the floor plan: along with the section a section line will be created on the floor plan. The length of 
this section line is equal with the width of the dynamic section plane. The position of the section line is defined as the 
horizontal centerline of the section plane projected on the floor plan. 
 



 4. Section 33 

 ARCHLine.XP® 2008 

 

 
 



34 5. Parking 

News  

5. Parking 

General 
Creating of parking area is one of the news in ARCHLine.XP. 
The program can create parking lots, rows and aisle ways inside the contour of a polygon, taking the standard vehicle size 
and aisle width into consideration. 
 

 
(Illés Papp, architect) 
 
The commands are available in Add-On menu – Parking. 
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5.1. Create parking 
Select the command from the menu. The well-known Profile definitions toolbar appears then. 
 

 
 
With the help of this you can draw the polygon contour of the parking area or you can specify a group of closed straight 
lines as a contour. After specifying the boundary lines, the Parking properties dialog appears. 
 

 

5.2. Properties 
You can specify the standard vehicle sizes, the aisle width and the inclination angle of parking lots. For the aisle ways 
neighboring with the perimeter parking lots and the inner parking lots you can specify if those should be one-way or two-
way (one aisle width or double aisle width). 
 
By pressing the OK button the program accepts the settings but nothing will change on the drawing yet. Select Parking 
regeneration from the menu and then select the parking area you want to regenerate with your cursor. 
 

 
 

5.3. List of parking lots 
This is a statistics about the different types of parking lots. Available parking lot types are: Private, Public, Hired, Disabled 
– wheel-chair, other. You have the possibility to export this list into an .xls document with the Save to Excel button. In this 
file you can find the same data; the summary and the path to the actual project that includes the parking area. With the 
Copy to clipboard button the ARCHLine.XP copies these data to the clipboard so later you can insert those into a 
document. 
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5.4. Boundary 
This is for the setting of contour lines by their functions. For each boundary line you can choose among 3 functions: 
Physical wall, Logical wall, Entrance or exit. By default all boundary lines are set to Physical wall. 
 

 
 

• In case of Physical wall a row of parking lots will be generated along the line. 
• In case of Logical wall parking lots will not be generated along the line but inner parking lots can start from here, the line 

will be the border of the inner zone. 
• In case of Entrance or exit an aisle way is created along the line and there are no parking lots placed. Here you can set 

the angle of entrance on both sides according to the direction of the connected road and the geometry of the parking area, 
respectively. A figure helps you to find out the position of angles. 
 
Using the Show in ARCHLine.XP option, the boundary line, the row of parking lots and the parking lot you select in the 
menu will be also selected on the floor plan. 
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5.5. Parking lots 
Each parking lot is numbered. The numbering starts from one. In this option you can set the type of the selected row of 
parking lots or the selected parking lot. The different types are: Private, Public, Hired, Disabled – wheel-chair, Other. 
 

 
 

5.6. Parking regeneration 
ARCHLine.XP regenerates the layout of parking lots according to the latest property settings. After selecting the 
command from the menu please click on the parking area you would like to regenerate. 
 

 
 
Any change you made in the parking properties will appear on the drawing of the parking area when you regenerate it. 
Even when you create a new parking area, the parking lots will appear after parking regeneration. 

5.7. New parking lot 
With this command you can place additional parking lots which are not generated automatically but your plan include 
them, one by one. Select the parking area where you want to place new parking lots. Specify the width, length and angle 
of the parking lot and then place it by one click. 
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5.8. Define 
You can specify the type of boundary lines of the parking area on the same way as you can do it in the dialog. Here you 
can select from three commands: Physical wall, Logical wall, Entrance/Exit. After selecting the desired command please 
click on the boundary line for which you want to change the type. After regeneration the change will be seen. 
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6. Artistic rendering - Sketch 

6.1. General 
A unique technology that supports rendering at the conceptual design stage and also allows the easy creation of 
impressionistic and stylized presentations at any point during the design process. 
Sketch works directly from the 3D model to give users the ability to instantly generate non-photorealistic and hand-drawn 
images that can very quickly be re-rendered from any viewpoint. A wide selection of sketch styles is available, including 
cartoon, pencil, ink, and various paint effects, so that users can create many different design impressions for presentation 
purposes.  
Images that show the 'concept' of a design are being increasingly used at the initial design stages of a project to enable 
open discussions with the designer's clients, as opposed to photorealistic images that may appear too 'finished' and 
thereby stifle constructive discussions.  
 
Supports the output of EPix format to Piranesi.  
 
Allows image parameters to be changed to create many other stylized effects, dramatically increasing the total number of 
styles possible, and allowing a style to be chosen which suits the user. 
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6.2. Sketch styles 
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7. Door / Window Frame around - Architrave 

You can assign frame to the inside or the outside of the 
doors or windows, and specify cross section. 
 
The frame is the property of the door or window, so it 
stays, when you copy it. 
 
You have to specify separately the inside and the outside 
properties of the frame. 

 

Frame properties: 
You can assign full frame or down opened frame. 
The cross section can be rectangular or profile selected from the library. 
You can put covering between the frame and reveal, and you can assign thickness and material to it. 
If you don’t assign any material to the frame or covering, then it copies its material from the wall. 
Click on the Door / Window Properties – Lining and architrave button to define the frame properties. 
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The following pictures show the different possibilities: 

 
 

 
 

Changing the position of the cross section 
• After clicking on the door / window on the floor plan the profile of the assigned frame is displayed. 
• You can mirror or rotate the profile by clicking on the profile and choosing Mirroring or Rotate keywords in the prompt 

line. 
 
Enter finishes the command. 
 
The advantage of the method is (contrary to changing Position profile window in the Property window) the result of the 
changing is viewable on the floor plan as compared to the door or window, so it is evident. 
 
 
Expanding frame Tapering frame 
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8. Roof structure developing 

Improved roof structure with more detailed roof construction that includes the independent Middle purlin, Ridge Board, 
enhanced ending Profile definition, Collar beam/tie. 
The program lists the sizes of the applied new structural elements, which makes it simple to carry out a cost calculation. 

Roof properties 

Before creating a roof, You can specify its properties. To do so, right-click on the  Roof icon in the toolbox or select 

the Modeling menu/toolbox - Properties − Roof command. 
 

� When You define an automatic roof, the command activates the Roof properties dialog. 
 
The Roof properties dialog comes up where You can set the roof properties. 

 

 
 
You can set the following properties: 
 

� Roof general and material properties, beam representation 
� Eaves purlin 
� Rafter 
� Batten 
� Middle purlin 
� Ridge board 
� Roof geometry 
� Projections, cut 

8.1. Roof properties main dialog 
In the roof properties main dialog You can set the Roof general properties, Materials and Beams. To set other properties, 
select the sub-dialogs. 

Roof general properties 
Roof properties include color, layer, line type, line width and priority properties, as it is the case with all other elements in 
ARCHLine.XP® . 
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	 See:  
� the description of General properties in Chapter 4.2.2. Specifying general properties, 
� the description of Sets in Chapter 4.2.4. Using sets of properties, and 
� the description of Cost variables in Chapter 4.2.5. Assigning variables. 

Materials 
To assign materials to the roof body and sides use the following buttons: 
 

� top surface 
material  

� roof body material  
� bottom surface 

material 
 

  
 
Select these buttons to display Material dialog box, where You can assign a material type to the roof. 
Use the Same materials option to assign the selected material to all sides. 

Beams  
The program generates the following parts of the roof structure automatically: 
 
Eaves purlin, middle purlin, ridge purlin, rafter, batten and collar beams 
 
The program creates the beams on both the 2D and the 3D model with the parameters set in the appropriate dialogs. 
 

After specifying the general properties of the roof, You can select the elements of the roof structure by switching the options. 
 

 
 

! Later You can specify the properties only for the selected elements of the roof structure. 
If the Create eaves purlin option is switched off, for example, the Eaves purlin sub dialog will not include the cross 
section input fields and therefore You cannot specify those parameters. 

Show roof in 3D 
If You only want to display only the beams in 3D, disable the Show roof in 3D option. If You do so, the roof planes will not 
be visible, only the roof structure. Switch on the Show roof planes with tile thickness option to represent the roof tiles with 
their thickness. 

Show beams 2D representation 
If You do not want to display the roof structure on the floor plan, disable the Show beams 2D representation option. 

Representation by centerline 
You can decide whether the beams should be appeared with their center line or projection on the floor plan. 
Of course, You can specify the line type of the beam representation in the appropriate dialogs. 
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Create eaves purlin 
Switch on the option to create the eaves purlins. In this case You can set its parameters in the Eaves purlin sub-dialog. 
Otherwise You can set only the height of the eaves purlin in the sub-dialog. (It defines the height of the roof.) 

Create rafter 
Switch on the option to create the rafters. In this case You can set their parameters in the Rafter sub-dialog. Otherwise the 
sub-dialog does not show the parameters.  

Middle purlin - Ridge board 
Switch on the options to create middle purlin and ridge board. The options are connected to the Create rafter option. It 
means You can create middle purlin or ridge board only when rafters are created as well. 
In this case You can set their parameters in the Middle purlin and Ridge board sub-dialogs. Otherwise the sub-dialogs 
don’t show the parameters.  

Show structure in 3D 
Switch on the option if You want to display the rafters, middle purlins and ridge board in a 3D model either. 
The representation of eaves purlins is also connected to the representation of rafters. 

Create battens for roof tiles 
Switch on the option to create the battens. In this case You can set their parameters in the Battens sub-dialog. Otherwise 
the sub-dialog does not show the parameters.  

Show battens in 3D 
Switch on the options if You want to battens for roof tiles. 
 
The Show in 2D and 3D options affect only the display. Turning them off has no effect on the beams − the modifications 
You made remain unchanged. 
 

 ! Do not turn off create beams options instead of turning show in 2D and 3D options! If You do so, You delete the whole 
beam structure and loose all modifications. 

Example 
If You switch on all options on the left side of the dialog, You will see the real roof structure of the roof on the section view, 
i.e. the eaves purlins, rafters, battens and roof tiles will be represented with their thickness.  
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The Delete and rebuild all rafters and eaves purlins / battens commands can only be used for individual modifications. 
If You previously carried out modifications on elements of the roof structure with the Shortcut menu − Roof framing 
command, You can disable the individual settings in one step, which is by turning on the options, and this way the 
properties set in the dialog box can be restored. 

	 See Chapter 1.1.1.2. Eaves purlin dialog, 1.1.1.3. Rafters dialog, 1.1.1.4. Battens for roof tiles dialog, 1.1.1.5. Middle purlin 
dialog, 1.1.1.6. Ridge board dialog. 
You can edit the beams thus created one by one or by roof planes with the Roof framing command in the Shortcut menu. 

 

8.2. Eaves purlin dialog 
The height of the bottom of eaves purlin determines the height of the roof.  
 

! This parameter must be specified even when there is no eaves purlin representation! In that case this parameter means 
the height of the reference line of the roof. 
 
 

 

Select Eaves purlin option on the left side of 
Properties dialog box to define the properties and 
position of eaves purlin. 

The general properties of eaves purlin are the same as 
in the case of other elements: color, line width, line type 
and material properties. 
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Relative height in relation to the current level - F 
You can define the height of the reference line (contour line) of the roof relative to the current level by the height of the 
eaves purlin. Also, this is the case when You don’t want to represent the joists in detail.  
You can specify not only the default height of the roof, but also the height of the rooftop. To do so, click on the icon. 

 

                        
 
 
You can set the next parameters in the Eaves purlin sub-dialog, when the Create eaves purlin option is switched on in the 
Property dialog: 
 

To adjust altitude of all eaves purlin to bottom of rafter 
With this option it is possible to represent those eaves purlins which do not match on the reference line. This is the case when the 
roof plane is defined by a reference line. By switching the option on, the eaves purlin on the opposite site of the reference line will 
be represented with the appropriate height, too. See the figure. 
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Offset from roof baseline (axis) – B 
You can define how far the centerline of the eaves purlin indicated in the figure should be horizontally from the roof 
baseline. 

Rectangular cross-section – C, D 
By default the cross-section profile of the 
eaves purlin is rectangular. You can enter the 
width and length of the rectangular profile in 
the appropriate fields.  
If You wish to define other profiles, press the 
Profile cross-section button to display the 
Position profile dialog box. You must define 
a closed profile. 
 

Eaves purlin ends 

 

By default the end of Eaves purlin is 
perpendicular. You can modify the profile of 
the ends. To do so, click Use profile button, 
then select the appropriate end-profile from 
Position profile dialog box. 
 

Relative height from the roof base line  
This field is active when You specify the eaves purlin properties individually. (Shortcuts menu – Roof framing – 
Properties... command). This way You can specify the height of the selected eaves purlin relative to the reference line so it 
can be different from the height of other eaves purlins. 
 
After defining the eaves purlin, You can return to the Properties dialog box by using the Arrow button 

. 

8.3. Rafters dialog 

 

Select the Rafters option on the left of the Properties 
dialog box to create the rafters for the building: 
 
To be able to create rafters, first You have to set rafter 
properties. The general properties of the elements of 
the roof structure are the same as in the case of all 
other elements: color, line width, line type and material 
properties. 
The individual rafter properties affect the relationship 
between roof structure elements and between roof 
structure elements and the roof. You can define the 
cross-section profile and end-profile of rafters, and the 
collar beams can be put into place. 
 

 
You can set the next parameters in the Rafter sub-dialog, when the Create Rafter option is switched on in the Property 
dialog: 
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Relative height from roof baseline− A 
Of the individual properties, first specify the relative height of rafters from the roof baseline. By specifying a negative 
value, You can display rafters in inner space. 
With Distance perpendicular to roof option You can instruct the program whether to set the relative height of rafters 
vertically or perpendicularly relative to the reference line. In this case the relative position of the eaves purlin and the rafter 
(value B) is given, so cannot be modified. 

Adjust to eaves purlin − B 
If You do not want to specify the position of the rafter in relation to the roof baseline, choose Adjust to eaves purlin 
option. In this case You can precisely define how deep the eaves purlin should cut into the rafter. 

Distance between roof and rafter ends − D 
If this option is disabled, rafters reach to the edge of the roof. Enable the option to specify distance between roof and rafter 
ends. 

Beam gap − E 
To put rafters into place specify the distance between the axes of the beams. 

Rectangular cross-section − F, G 
 

 

By default the cross-section profile of the rafters is 
rectangular. You can enter the width and length of this 
rectangular profile in the appropriate fields. If You wish 
to define other profiles, press Profile cross-section 
button to display Position profile dialog box. You must 
define a closed profile. 
 

	 See the description of Position profile dialog in Chapter 7.5. Specifying profile – Select from list. 
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Rafter ends 

 

By default the end of rafters is perpendicular. You can set it 
vertical by enabling Vertical edge on bottom option. 
 

You can modify the profile of the rafter-ends. To do so, click Use profile button, then select the appropriate end-profile 
from Position profile dialog box. You can choose from various default profiles, and You can create individual profiles, too. 
You can save these in the Profile directory. In case of traditional Hungarian peasant houses it is common to use rafters 
whose ends have been decorated, so we recommend that You use this method. 
 

� You can save a completed profile in the profile directory by  Object library  − Open profile or  Closed 
profile commands. 

Build with collar beam −  
Enable this option to display the collar beam /tie. Clicking the button, the dialog appears: 
 
Select the option: Collar beam of Tie 
 

 
 
You can specify the cross section of the beam: A, B and the distance between the beams: C, in case of tie.  
You can use these parameters from the rafter, if You switch on the To use rafter size option. 
 
You can specify the height of the collar beam: D relative to the roof reference line or relative to the actual floor: E. 

  
 
Collar beam   Tie 
 
The program only displays the collar beams /ties if the opposite rafters are precisely joined. 
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� If the program did not join the rafters of opposite joining roof planes, You can do so with Shortcut menu − Roof framing − 
Move command. With this command You can move together the rafters belonging to one roof plane. Following this You 
can edit the collar beam. 
 
After defining the rafters, You can return to the Properties dialog box by using the Arrow button 

. 

8.4. Battens 
Select Batten option on the left of the Property dialog to set the general and the special properties of battens. 
You have to define the distance from the roof reference line, distance between the axis of beams and the cross-section, 
distance of the first batten from the rafter end. 
Instead of defining the distance from the roof reference line You can adjust battens to the top of the rafters. 
 
You can set the next parameters in the Battens sub-dialog, when the Create battens for roof tiles option is switched on in 
the Property dialog: 
 

 

Relative height from roof baseline− A 
Of the individual properties, first specify the relative height of batten from the roof baseline.  

Adjust to rafter − F 
If You want to specify the position of the batten in relation to the rafter, choose Adjust to rafter option. In this case You 
can define the relative height of batten from the rafter. 

First rafter from rafter ends − B 
If this option is disabled, batten reach to the rafter end. Enable the option to specify distance between the first batten and 
rafter end. 

Distance of battens − C 
To put battens into place specify the distance between the axes of the beams. 
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Rectangular cross-section − D, E 
By default the cross-section profile of the rafters is rectangular. You can enter the width and length of this rectangular 
profile in the appropriate fields. If You wish to define other profiles, press Profile cross-section button to display Position 
profile dialog box. You must define a closed profile. 

 
After defining the battens, You can return to the Properties dialog box by using the Arrow button 

. 
 

8.5. Middle purlin 
Select Middle purlin option on the left of the Property dialog to set the general and the special properties of middle purlin. 
 
You can set the next parameters in the Middle purlin sub-dialog, when the Middle purlin option is switched on in the 
Property dialog: 
 

 

Relative height from roof baseline− F 
Of the individual properties, first specify the relative height of middle purlin from the roof baseline. 
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Deep in rafter− B 
After specify the deep the middle purlin should cut into the rafter.  
The parameters F and B define preciously the place of the middle purlin. 

Rectangular cross-section − C, D 
By default the cross-section profile of the middle purlin is rectangular. You can enter the width and length of this 
rectangular profile in the appropriate fields. If You wish to define other profiles, press Profile cross-section button to 
display Position profile dialog box. You must define a closed profile. 

Rafter ends 
By default the end of rafters is perpendicular. You can modify the profile of the middle purlin ends. To do so, click Use 
profile button, then select the appropriate end-profile from Position profile dialog box.  
 
After defining the middle purlin, You can return to the Properties dialog box by using the Arrow button 

. 

 

8.6. Ridge board 
Select Ridge board option on the left of the Property dialog to set the general and the special properties of ridge board. 
 
You can set the next parameters in the Ridge board sub-dialog, when the Ridge board option is switched on in the 
Property dialog: 
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Relative height from rafter intersection− B 
You can specify the relative height of ridge board from the rafter intersection. 
 

! If a B < D/3, then rafters ends are met at the top. Otherwise the rafter ends on the top are adjusted to the ridge board. 

  
 
 
B= 1 cm, D=16 cm  B= 13 cm, D=16 cm 

Rectangular cross-section − C, D 
By default the cross-section profile of the ridge board is rectangular. You can enter the width and length of this rectangular 
profile. If You wish to define other profiles, press Profile cross-section button to display Position profile dialog box. You 
must define a closed profile. 

Rafter ends 
By default the end of ridge board is perpendicular. You can modify the profile of the ridge board ends. To do so, click Use 
profile button, then select the appropriate end-profile from Position profile dialog box.  
 
After defining the ridge board, You can return to the Properties dialog box by using the Arrow button 

. 
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8.7. Roof geometry 
Select Roof geometry option on the left of the Property dialog to set the special properties of roof. 
 
By the roof structure setting there are two different opportunities in the roof geometry window: 
 

� the program adjusts the tiles to the tiles batten 
� the program doesn’t adjust the tiles to the tiles batten 

 

 

I) Tiles adjusting to the batten – using the eaves purlin  
In this situation the program supports to create a classical roof structure: 
 

• In the eaves purlin window:  
define the height of the reference line with the bottom of eaves purlin. 

• In the rafter window:  
set the height of the rafter considering, how much it cuts to the eaves purlin. Maybe set the rafter on the eaves purlin.  

• In the tiles batten window:  
define the height of the batten. You can ask to set it on the rafter. 

• In the roof geometry window:  
Switch on the Adjust batten and tile. Define the whole thickness of roof, within tile thickness.  
 
We can get the roof thickness 
automatically, if we adjust the 
thickness to the bottom of the 
rafter. (This way the thickness of 
roof is equivalent with the sum 
thickness of rafter, tiles batten and 
tile. In this situation the F 
parameter usually isn’t equal with 
B parameter, that is, the distance 
from the top of the roof and the 
reference line isn’t equal with the 
thickness of roof.) 

� In the roof property window: 
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We get the following type of roof 
structure, if we switch on the 
appearance of eaves purlin, rafter, 
batten and tile: 

 

 

 
(János Varga, architect) 

II) Tiles adjusting to the batten – no eaves purlin 
The adjusting are the same as in point l), except with the use of eaves purlin:   
 

• This time You also define the height of the roof in the Eaves Purlin window, but of course, in this case the F parameter 
means the distance of roof reference line from the bottom of actual floor.  
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• In the rafter window:  
by adjusting the height of rafter: A 
= 0.0 m. 

• In the tiles batten window:  
You can adjust the tiles batten to 
the rafter top: F=0.0 m. 

• In the roof geometry window:  
Switch on the Adjust batten and 
tile. As we adjusted the rafter to 
the reference line of the roof, it 
can here realize that F parameter 
can be equal with B parameter. 

• In the roof property window: 
We get the following type of roof 
structure, if we switch off the 
eaves purlin option: 

 
 

• In the roof property window: 
We get the following type of roof structure, if we switch 
off all options regarding to roof structure. 

 

  
 

� If You switch on the Adjust rafter to eaves purlin option, the software counts the adjust with the eaves purlin’s height, if 
there isn’t eaves purlin at all. It’s also true for the Adjust batten to rafter top, and the Adjust roof thickness to rafter 
bottom options. 

III) Don’t adjust the tiles batten to the tile 
In this case we can apply the regular method, as in earlier versions of ARCHLine.XP: 
 

� This means, that we can define the height of different roof structure elements independent and free of each other. The 
result of the large freedom, that You can create with the roof tool not just roof element (we offer this just for skillful users). 

� You can visualize the original state by loading earlier plan. 
 
Make the following adjustment: 
 

• In the roof geometry window:
 
Switch off the Adjust batten and tile. Switch on the F=B to reach, that the distance from the top of the roof and the 
reference line be equal with the thickness of roof. 
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For example with this method You can create metal construction glass-roof. Form the metal structure from rafters and tiles 
battens. 

 

  
� Other parameters 

 Roof thickness - B 
You can define roof thickness vertically or perpendicular to the roof plane. 
 

 

Relative to the vertical projection, while the 
end of the roof is vertical. 

 

 

Roof thickness is perpendicular to the roof 
plane; the roof ending is also perpendicular. 
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Roof thickness is perpendicular to the roof 
plane; the roof ending is vertical to the roof 
plane. 

 
� Adjust roof thickness to rafter bottom 

With this option You can define the thickness of the roof by the distance between the top of the roof tile and the bottom of 
the rafter. 
 

� Total roof thickness is represented in 3D only in the case when Show roof in 3D option is turned on and Show roof 
planes with tile thickness option is turned off in the Roof properties dialog box. 
 

� Total distance – F 
Total distance, i.e. the distance between the reference line of the roof and the top of the tile, is also displayed. You can 
use also this value as total roof thickness.  
 

� Tile thickness – T 
Here You can define the thickness of the tile. If the Show roof planes with tile thickness option is turned on in the Roof 
properties dialog box, tile will be represented on section view.  
 

�   Roof slope - A 
Define roof slope in degrees or as the percentage of its deviation from horizontal direction. (Click on the appropriate icon 
to select degrees or percentages.) 
 

�   Roof thickness at end - C 
You can apply this method with the different eaves types (see the examples). You can cut the end of the roof by using a 
value smaller than the one applied to the vertical projection. 
The No option means that there is no horizontal cut. 

• Click on the icon to create the desired roof, which connects to the wall, and then specify thickness. 
 

Example: roof thickness: 0.3 m 

  
Roof thickness at end: 

 No  0.2 m  0 m  0.3 m  
 

�  Roof overhang - D 
This is used with automatic or simple roofs. The actual contour of the roof will overhang the contour of the walls with the 
specified value. 
 

�  Ridge height - E 
In case of the No limit option the program calculates ridge height on the basis of the roof slope and the roof thickness. 
You can use a value smaller than the maximum value. If You do so, the result is the form illustrated by the second image. 
When You specify a value, it is measured from the reference line of the roof. 
 

 
The program does not accept higher values than the default value. 
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8.8. Projections and cut 
Select Projections and cut option on the left of Properties dialog to display the following dialog box: 

 

 

Cut 
You can choose from the automatic wall-roof cut options: 
 

 

• Cuts the walls on the current 
floor. 
Switch on this option in case of 
attic rooms. 

• Cuts the walls of all floors. 
This option is useful in case of 
alpine houses. 

• Does not cut walls automatically. 
• Cuts the walls on the current floor and on the floor below. 

This option is useful in case of walls under a so called “dog’s house roof”. 
 

� To see the result achieved by applying the cut options, enable Wall-slab-roof cut option in Build 3D model  
dialog.  

Projection 
You can display the roof in 2D on its own floor, one floor above or one floor below. You can define which line type You 
wish to apply to the roof structure on each floor. 

Ridge-tile and Water spout 
You can specify whether to tile the intersection of the roof planes with ridge-tiles and water spout. If You enable the option 
You have to define their width, thickness and material. 
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This is a global setting, which 
applies to all roofs on the 
floor plan, even the ones 
previously drawn. 
After this You can only 
modify ridge-tiles in 
Properties dialog box,  

 which You can activate by clicking on the  icon, or by the Properties – Roof command.  
 
After completing the settings, You can return to the Properties dialog box by using the Arrow 

button . 
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9. Balustrade developing 

With the new Balustrade wizard you can create sophisticated individual balustrades. There are new balustrade sets for 
quick balustrade definition with or without stair. 
 

� Balustrade became an independent element type 
 

 
 

� Balustrade properties can be stored in sets. There are new balustrade sets. 
� When you place a stair, it is represented together with the selected balustrade. 

9.1. Balustrade arranged in sets 
Balustrade properties can be saved into sets. The program includes pre-defined basic sets from which you can choose. 
If you select a set, the balustrade will be created along the specified path without showing up the balustrade wizard, thus 
making the design process faster. 
 

 

Some of the new balustrade sets: 
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9.2. Stair with balustrade 
In the stair properties dialog you can select balustrade sets to the left and the right side. When you place a stair, it will be 
represented together with the balustrade. 
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10. Creating of detailed view 

Design offices often use pre-defined modules (drawing parts, detailed views) for their work.  
They use pre-defined bathroom modules in different flats, for example. 
 
The Tools menu – Detailed view – Export to library command satisfies this requirement. 
With the help of this you can create a detailed view from the floor-plan on the active floor and put it into the selected 
library. 
The detailed view keeps the architectural elements and the 3D model, too (if those are included). A 2D drawing can be 
also saved as detailed drawing, of course. 
Later you can place the detailed view as a module from the library onto the floor-plan. 
The detailed view placed in that way is a group; by entering into the group you can modify its elements, and so the 
architecture elements as well. 
 

• Activate the window that includes the floor-plan, and then go to the desired floor. 
• Select the Tools menu – Detailed view – Export to library command. 
• In the appearing Choose Oli dialog create a new library or select an existing user-defined one in the Detailed folder, for 

example Bath.oli. 
• Specify the name of the detailed view. 

 
 

• Open the desired project. 
• Drag and drop the detailed view from the Design Center to the floor-plan. 
• If necessary, enter into the group and modify its elements. 



 10. Creating of detailed view 71 

 ARCHLine.XP® 2008 

• Close the group. 
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11. Revision Cloud 

Revision cloud is commonly used on drawings to illustrate a design change. The revision cloud is made up of polyline 
arcs.  
 
Revision cloud can be used in two ways: 
 

� As a polygon to outline a drawing part, for example, 
� As a text frame. 

 Revision cloud as a polygon 

Availability: Drafting tool – Polygon -   Revision cloud 
 
Revision cloud works like polygon command, define the start point and the next points of a polygon to create the cloudlike 
effect. Complete the command by pressing mouse right click or Enter.  
 
Revision cloud is using the polyline attributes, so you can edit it as a polyline. 

 
 

Revision cloud as text frame 
Revision cloud is usable for text and dimension as well. It is a new text frame around attribute selectable from the list of 
the "No bounding", "Bounding box" "Bounding Circle" and “Cloud” frame attributes. 
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12. Others 

12.1. Room book 
Automatic refreshment of the summary table of all room books. 

The  Refresh all command refreshes all the room books on the drawing and the related summary table of all room 
books. 
The automatic refreshment will be executed on the first placed summary table on the drawing. The automatic refreshment 
is only an option. You can cancel the refreshment. In that case the table will be deleted. 

12.2. Wall 
Wall X connection - connect walls automatically  

Creating wall connection with X crossing is also automatic. 
 

 
The X connection command in the wall local menu cuts the selected wall in the intersection of the nearest wall, and then it 
connects the created walls to the cutting wall with T connection. 
 

 

 

Axis line of wall 
The axis line of wall can be represented. In case of layered wall, the axis line fits to the center line of the displayed layer.  
The properties of the axis line can be specified: color, line type, line thickness. The elongation of the axis line can be 
specified. 
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Full color hatch 
Full color hatch can be also applied for hatching a wall. 

12.3. Priority of architectural elements 
Priority is added to the properties of architectural elements 

 

12.4. Stair 
The use of Stair 2D <- restore command became easier. In the appearing dialog the program shows the list of identifiers of 
those stairs which have been converted to 2D shadow. This way it is easy to select the required identifier and enter it into 
the command line. You do not have to remember to it. 
 

� If there is no real stair on the floor-plan and you cannot start the restoring command from the local menu, it is worth to 
place a temporary stair to use its local menu. 
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12.5. Doors/windows 
Wall representation between doors/windows placed next to each other is eliminated.  
 

 

 

12.6. New door/window libraries 
Glass doors: 
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Shuttered windows 

 

Louver window 

 

12.7. Curtain wall  
Divider has two parameters: width in X and width in Y 

12.8. Balustrade 
In case of balustrade cost parameters the Length parameter means the length of balustrade. 

12.9. Column, beam: Copy properties 
In case of columns, beams and objects the Insert into wall property can be copied by the Copy properties command. 
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12.10. Edit floor levels dialog – Move objects to other floor 
Beside the Copy objects to other floor command you can also move objects to other floor. 

 

12.11. Representation - Shadow 
In the 3D drawing window the representation of shadow hatches without contour lines is available. 
 

 

12.12. Dimension - Remove associativity 
With the help of this command the length and distance dimensioning can be converted to non-associative dimensioning. 
The command does not change the non-convertible dimensioning like radius, diameter etc. 
The command is available in the Dimension menu – Options submenu. 
With this command it is possible to copy wall dimensioning (created and converted to non-associative on a floor) to 
another floor if the walls are identical on both floors. So it is not necessary to create the same dimensioning again. 
 
The tooltip includes the associativity information. 
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12.13. Text 
The distance between bounding box and the text can be specified as a percent value relative to the character height. 
 

 
 

 

12.14. New group libraries 
More group libraries are added to the program. These are as follows: 
 

� Single circle signs 
� Single square signs 
� Vertical simple circle legend signs 
� Vertical simple square legend signs 
� Consignation signs 
� Circle signs 
� Arrows 
� Square signs 
� Horizontal simple circle legend signs 
� Horizontal simple square legend signs 

New line types dialog 
In the line types dialog the desired line type can be accessed easily by the slide bar. 
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13. Installation files and folders 

ARCHLine.XP® 2008 has complete Setup support to Microsoft Windows Vista. 

13.1. Using ARCHLine.XP® as a limited user 
In releases prior to ARCHLine.XP® 2008, you were required to have computer administrator rights to run ARCHLine.XP®. 
CadLine removed the computer administrator requirement and you can now run ARCHLine.XP® as a limited user. As a 
result, your customizable files had to be moved to a location where you have access to them. The previous location of 
those files (Program Files\Archline.XP 2007, for example) is Read Only (for example you cannot update files in this 
location as a standard user on Windows Vista). The new location of your project and drawing files, the ARCHlineXP Draw 
subfolder in your own documents folder, allows you to create and modify own files. 
 
To install ARCHLine.XP®, you must still either have administrator permissions or be granted elevated permissions by your 
system administrator. See your system administrator for information about administrator and elevated permissions. 
 

! If you are not the user who installed ARCHLine.XP®, you must run ARCHLine.XP® from the Start menu or from the 
desktop shortcut icon. As a different user who installed ARCHLine.XP®, you cannot run ARCHLine.XP® at first time from 
the folder where it is installed (for example, c:\Program Files\ARCHLine.XP 2008\Exe\ARCHLineXP2008.exe). 

13.2. Locate files 
In ARCHLine.XP® 2008, the location of some of your installation files has changed. The reasons for the file location 
changes include the followings: 
 

� Limited user rights on a workstation. You can run ARCHLine.XP®  as a limited user. This means that you no longer need 
power user or Administrator permissions to run ARCHLine.XP®  once it is installed. The ability to run ARCHLine.XP®  as a 
limited user was introduced in ARCHLine.XP®  2008. 
 

� Vista compatibility. Because of the User Account Control applied in Windows Vista, the read only program files have to be 
separated from other customizable files and folders that can be written or overwritten by standard users. 

 

� In some operating systems, the folders that are located under your profile are hidden by default. To view these files, you 
may need to turn on the Show hidden files and folders option in the folder options dialog. 

 

13.3. Read only program files location 
The executable and dll files with the connected files remained in the Program Files directory: 

 

13.4. Project directory 
In ARCHLine.XP® 2008, the default location of your drawing and project files has changed to My Documents\ARCHlineXP 
Draw (in Windows XP operating system): 
 

 
 
Also, in this folder you can find the default Archive directory for automatic archiving. 
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In Windows Vista, you can find this folder in your Documents folder: 
 

 

13.4.1. Locate project directory 
To locate your default project directory: 
 

• Start ARCHLine.XP®. 
• In the File menu – Preferences – General dialog select File locations. 
• As you click the Project default path ellipsis button, a window will popup allowing you to locate and modify your default 

project directory. 
 

 

13.4.2. Locate archive files 
To locate your default path of your archive files: 
 

• Start ARCHLine.XP®. 
• In the File menu – Preferences – General dialog select File locations. 
• Make sure that the Archive files option is switched on. 
• As you click the Default path ellipsis button under Archive files option, a window will popup allowing you to locate and 

modify your default archive files directory. 
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13.5. Common application data directory 
Most of the customizable installation files have been moved to the common application data files folder: 
 

 
 

� In some operating systems, the folders that are located under all users profile are hidden by default. To view these files, 
you may need to turn on the Show hidden files and folder option in the folder options dialog. 

 
On Windows Vista: 
 

• The Organize menu -> Layout -> Menu Bar option must be switched on. 
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• Open the Tools -> Folder Options.. dialog. 
 

 
 

• In the View tab select the Show hidden files and folders option: 
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In the c:\ProgramData\Cadline folder you can find the ARCHlineXP2008 directory: 
 

 
 
 
By default: 

� Documentation directory is used for documentation files. 
� Images directory is used for images used in the Sun position dialog. 
� Materials directory is used for texture and material files used by ARCHLine.XP®. 
� Oli directory is used for object libraries of different element types and auxiliary Pascal macro files. 
� Support directory is used for the templates files, design center elements, translation files etc. 
� Temp directory is used for the current project temporary management and all files that belong to the current project. 
� Templates directory is mainly used for files that necessary for the creation of Word and Excel lists. 
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13.5.1. Locate material directory 
To locate your default material directory: 

• Start ARCHLine.XP®. 
• In the File menu – Preferences – General dialog select File locations. 
• As you click the Material default path ellipsis button, a window will popup allowing you to locate and modify your default 

material directory. 
 

 

13.5.2. Locate user defined object libraries 
To locate your default paths used for user defined object libraries of objects, plinths, doors, windows, profiles or groups: 

• Start ARCHLine.XP®. 
• In the File menu – Preferences – General dialog select File locations. 
• Under User defined object libraries you can find the path information of user defined objects, plinths, doors, windows, 

profiles and groups. As you click the Object/Plinth/Door/Window/Profile/Group ellipsis button, a window will popup allowing 
you to locate your user defined .oli files used for objects/plinths/doors/windows/profiles/groups. 

 

 
 

13.5.3. Locate template file 
To locate your template file used for default sets and other settings: 

• Start ARCHLine.XP®. 
• In the File menu – Preferences – Template management dialog you can locate and modify your template file: 
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